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1 Einführung

1.1 Gültigkeit der Dokumentation
Die Dokumentation ist gültig für das Produkt IndustrialPI AIO. Sie gilt, bis eine neue Doku-
mentation erscheint.

Diese Bedienungsanleitung erläutert die Funktionsweise und den Betrieb, beschreibt die
Montage und gibt Hinweise zum Anschluss des Produkts.

1.2 Nutzung der Dokumentation
Dieses Dokument dient der Instruktion. Installieren und nehmen Sie das Produkt nur dann
in Betrieb, wenn Sie dieses Dokument gelesen und verstanden haben. Bewahren Sie das
Dokument für die künftige Verwendung auf.

1.3 Zeichenerklärung
Besonders wichtige Informationen sind wie folgt gekennzeichnet:

GEFAHR!

Beachten Sie diesen Hinweis unbedingt! Er warnt Sie vor unmittelbar dro-
henden Gefahren, die schwerste Körperverletzungen und Tod verursachen
können, und weist auf entsprechende Vorsichtsmaßnahmen hin.

WARNUNG!

Beachten Sie diesen Hinweis unbedingt! Er warnt Sie vor gefährlichen Si-
tuationen, die schwerste Körperverletzungen und Tod verursachen können,
und weist auf entsprechende Vorsichtsmaßnahmen hin.

ACHTUNG!

weist auf eine Gefahrenquelle hin, die leichte oder geringfügige Verletzun-
gen sowie Sachschaden zur Folge haben kann, und informiert über entspre-
chende Vorsichtsmaßnahmen.

WICHTIG

beschreibt Situationen, durch die das Produkt oder Geräte in dessen Umge-
bung beschädigt werden können, und gibt entsprechende Vorsichtsmaß-
nahmen an. Der Hinweis kennzeichnet außerdem besonders wichtige Text-
stellen.
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INFO

liefert Anwendungstipps und informiert über Besonderheiten.
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2 Übersicht
Mit diesem Erweiterungsmodul können Sie analoge Sensoren, Aktoren und Temperaturfüh-
ler an Ihr IndustrialPI-System anschließen.

2.1 Produktmerkmale
} Erweiterungsmodul für den IndustrialPI 4
} 4 analoge Eingänge für Strom oder Spannung
} 2 analoge Ausgänge für Strom oder Spannung
} 2 RTD-Kanäle für Temperaturfühler Pt100 oder Pt1000
} verschiedene Ausgangsspannungsbereiche und Ausgangsstrombereiche sind konfigu-

rierbar.
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3 Sicherheit

3.1 Sicherheitsvorschriften

3.1.1 Qualifikation des Personals
Aufstellung, Montage, Programmierung, Inbetriebnahme, Betrieb, Außerbetriebnahme und
Wartung der Produkte dürfen nur von hierzu befähigten Personen vorgenommen werden.

Eine befähigte Person ist eine qualifizierte und sachkundige Person, die durch ihre Berufs-
ausbildung, ihre Berufserfahrung und ihre zeitnahe berufliche Tätigkeit über die erforderli-
chen Fachkenntnisse verfügt. Um Produkte, Geräte, Systeme, Maschinen und Anlagen
prüfen, beurteilen und handhaben zu können, muss diese Person Kenntnisse über den
Stand der Technik und die zutreffenden nationalen, europäischen und internationalen Ge-
setze, Richtlinien und Normen haben.

Der Betreiber ist außerdem verpflichtet, nur Personen einzusetzen, die
} mit den grundlegenden Vorschriften zur Arbeitssicherheit und Unfallverhütung vertraut

sind,
} den Abschnitt Sicherheit in dieser Beschreibung gelesen und verstanden haben und
} mit den für die spezielle Anwendung geltenden Grund- und Fachnormen vertraut sind.

3.1.2 Gewährleistung und Haftung
Gewährleistungs- und Haftungsansprüche gehen verloren, wenn
} das Produkt nicht bestimmungsgemäß verwendet wurde,
} die Schäden auf Nichtbeachtung der Bedienungsanleitung zurückzuführen sind,
} das Betreiberpersonal nicht ordnungsgemäß ausgebildet ist,
} oder Veränderungen irgendeiner Art vorgenommen wurden (z. B. Austauschen von Bau-

teilen auf den Leiterplatten, Lötarbeiten usw).

3.1.3 Entsorgung
} Beachten Sie bei der Außerbetriebnahme die lokalen Gesetze zur Entsorgung von elek-

tronischen Geräten, z. B. Elektro- und Elektronikgerätegesetz.
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4 Funktionsbeschreibung

4.1 Analoge Eingänge
Die analogen Eingänge können entweder als Strom- oder Spannungseingänge verwendet
werden. Der Eingangsbereich für die Strom- und Spannungswerte ist einstellbar. Für die
Umrechnung in andere Einheiten oder zur nachträglichen Kalibrierung ist eine Skalierung
möglich. Diese und weitere Einstellungen werden mit der Browser-basierten Applikation
PiCtory durchgeführt (siehe Konfiguration [  15]).

4.2 Analoge Ausgänge
Die analogen Ausgänge können entweder Strom oder Spannung ausgeben. Die Wertebe-
reiche für Strom und Spannung sind einstellbar. Für die Umrechnung in andere Einheiten
oder zur nachträglichen Kalibrierung eines Aktors ist eine Skalierung möglich. Diese und
weitere Einstellungen werden mit der Browser-basierten Applikation PiCtory durchgeführt
(siehe Konfiguration [  15]).

4.3 RTD-Kanäle
Die RTD-Kanäle können für Temperaturmessungen mit Pt100- und Pt1000-Sensoren ein-
gesetzt werden. Als Messverfahren steht die 2-Draht-, 3-Draht- oder 4-Draht-Messmethode
zur Verfügung. Für die Umrechnung in andere Einheiten oder zur nachträglichen Kalibrie-
rung eines Temperaturfühlers ist eine Skalierung möglich. Diese und weitere Einstellungen
werden mit der Browser-basierten Applikation PiCtory durchgeführt (siehe
Konfiguration [  15]).
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5 Montage
IndustrialPI-Module wurden für den Einsatz in einem Schaltschrank oder Gehäuse entwi-
ckelt. Um sie bestimmungsgemäß in einem industriellen Umfeld zu betreiben, müssen Sie
folgendes beachten:
} Die Schutzart und Schutzklasse des Schaltschranks oder Gehäuses muss den für den

Einsatzzweck vorgesehenen Normen entsprechen.
} Für die Montage im Schaltschrank benötigen Sie eine Montageschiene 35 x 7,5 mm

(EN50022).
} Montieren Sie die Montageschiene nach Herstellerangaben waagerecht im Schalt-

schrank. Nur bei waagerechter Montage ist sichergestellt, dass Luft von unten nach oben
durch die IndustrialPI-Module strömt und dabei die Elektronik kühlen kann (Kamineffekt).

} Achten Sie darauf, dass das IndustrialPI ausreichend Abstand zu anderen Produkten hat,
um eine ausreichende Luftumströmung zu gewährleisten

Vorgehen:
} Halten Sie das Rasterelement des IndustrialPI-Moduls an die Montageschiene.
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} Drücken Sie die Arretierungen in Richtung des IndustrialPI-Moduls zu.
} Stellen Sie sicher, dass das IndustrialPI-Modul fest mit der Montageschiene verbunden

ist.

WICHTIG
Durch zu hohe Temperaturen kann das Modul beschädigt werden!

Achten Sie darauf, dass die Umgebungstemperatur im Schaltschrank gerin-
ger als 55 °C ist.



Verdrahtung

Bedienungsanleitung IndustrialPI AIO
1006974-DE-01

| 11

6 Verdrahtung
Die PiBridge ist ein Backplanebus, mit dem Sie alle Module aus der IndustrialPI-Familie
miteinander verbinden können.

Mit der PiBridge können folgende Erweiterungsmodule angeschlossen werden:

Bis zu zehn Erweiterungsmodule (z. B. unsere IO-Module), davon fünf Erweiterungsmodule
links und fünf Erweiterungsmodule rechts.

Stecken Sie PiBridge, wie abgebildet [1], auf die PiBridge-Anschlüsse der Produkte, die Sie
verbinden möchten.

Die Daten werden über Signalleitungen von einem Modul über die PiBridge auf das andere
Modul übertragen.

[1]
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6.1 Klemmenbelegung

[1]

[2]

[3]

Position Anschluss

1 Status-LEDS
Die LEDs zeigen an, ob das IndustrialPI AIO richtig funktioniert
oder ein Problem besteht.

2 Anschluss für Aktoren und Sensoren
Beachten Sie die Belegung der Pins. Das ist sehr wichtig,
denn die Anschlüsse ändern sich je nach Messverfahren und
Signalart.

3 Netzanschluss
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Pinbelegung für Anschluss der Aktoren und Sensoren:

PIN Zuordnung Bezeichnung Verwendung

1 Ausgang 1 V+ positiver Ausgang für Spannungsbereiche
Kanal 1

2 Ausgang 2 V+ positiver Ausgang für Spannungsbereiche
Kanal 2

3 Ausgang 1 I+ positiver Ausgang für Strombereiche Kanal
1

4 Ausgang 2 I+ positiver Ausgang für Strombereiche Kanal
2

5 Ausgang 1 – gemeinsame Masse beider Ausgangskanäle
1 und 2 (Strom und Spannung)

6 Ausgang 2 – gemeinsame Masse beider Ausgangskanäle
1 und 2 (Strom und Spannung)

7 Ausgang 1 – gemeinsame Masse beider Ausgangskanäle
1 und 2 (Strom und Spannung)

8 Ausgang 2 – gemeinsame Masse beider Ausgangskanäle
1 und 2 (Strom und Spannung)

9 RTD 2 weiß negativer Messstrom, 3- u. 4-Draht, bei 2-
Draht Brücke zu Pin 18

10 RTD 1 weiß negativer Messstrom, 3- u. 4-Draht, bei 2-
Draht Brücke zu Pin 12

11 Eingang 4 – negativer Eingang für Strom oder Span-
nungsmessung Kanal 4

12 RTD 1 weiß negativer Messeingang, 2-, 3- u. 4-Draht,
Kanal 1

13 Eingang 4 * von hier zu Pin 15 muss für Strommessun-
gen eine Drahtbrücke eingebaut werden

14 RTD 1 rot positiver Messeingang, 2-, 3- u. 4-Draht, Ka-
nal 1

15 Eingang 4 + positiver Eingang für Strom oder Span-
nungsmessung Kanal 4

16 RTD 1 rot positiver Messstrom, nur 4-Draht, Kanal 1

17 Eingang 3 – negativer Eingang für Strom oder Span-
nungsmessung Kanal 3

18 RTD 2 weiß negativer Messeingang, 2-, 3- u. 4-Draht,
Kanal 2

19 Eingang 3 * von hier zu Pin 21 muss für Strommessun-
gen eine Drahtbrücke eingebaut werden

20 RTD 2 red positiver Messeingang, 2-, 3- u. 4-Draht, Ka-
nal 2

21 Eingang 3 + positiver Eingang für Strom oder Span-
nungsmessung Kanal 3

22 RTD 2 rot positiver Messstrom, nur 4-Draht, Kanal 2
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PIN Zuordnung Bezeichnung Verwendung

23 Eingang 2 – negativer Eingang für Strom oder Span-
nungsmessung Kanal 2

24 Eingang 1 – negativer Eingang für Strom oder Span-
nungsmessung Kanal 1

25 Eingang 2 * von hier zu Pin 27 muss für Strommessun-
gen eine Drahtbrücke eingebaut werden

26 Eingang 1 * von hier zu Pin 28 muss für Strommessun-
gen eine Drahtbrücke eingebaut werden

27 Eingang 2 + positiver Eingang für Strom oder Span-
nungsmessung Kanal 2

28 Eingang 1 + positiver Eingang für Strom oder Span-
nungsmessung Kanal 1

6.2 Spannungsversorgung
Schalten Sie die Spannungsversorgung erst an, wenn die Module auf der Hutschiene mon-
tiert und alle Stecker gesteckt sind. Module, die über die PiBridge bereits verbunden sind,
müssen immer gleichzeitig mit Spannung versorgt werden. Prüfen Sie vor dem Einschalten
noch einmal die korrekte Polarität der Spannungsversorgungsanschlüsse aller Module! Sie
können IndustrialPI -Geräte in einem Spannungsbereich von 12 V bis 24 V betreiben.
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7 Konfiguration

7.1 Analoge Eingänge konfigurieren
Mit PiCtory können Sie Ihr IndustrialPI AIO konfigurieren. In diesem Kapitel werden die Ein-
stellwerte des “Value-Editors” für die analogen Eingänge beschrieben.

Voraussetzungen:
} Sie haben einen Webbrowser auf Ihrem PC installiert (z. B. Chrome).
} IndustrialPI 4 befindet sich in Ihrem Netzwerk.

Ihr AIO besitzt 4 analoge Eingänge. Diese Eingänge können entweder als Spannungs-
oder Stromeingang eingestellt werden. Sie können hier Sensoren, wie zum Beispiel Nähe-
rungs- oder Füllstandsensoren mit Analogausgängen (typischer Weise 4-24 mA oder 0-10
V) anschließen.

ACHTUNG!

Die maximale Gleichtaktspannung für alle 4 Eingänge darf nicht höher
als 45 V sein.

Damit Ihre Konfiguration auch funktioniert, ist es wichtig, dass Ihre Produkte an die richti-
gen Eingangspins angeschlossen sind.
} Öffnen Sie Ihren Webbrowser.
} Geben Sie die IP-Adresse Ihres IndustrialPI 4 in die Adresszeile Ihres Browsers ein.

Das Anmeldefenster öffnet sich.
} Melden Sie sich mit dem Benutzernamen “admin” an.
} Geben Sie Ihr Passwort ein. Sie finden es auf dem Aufkleber an der Seite Ihres Industri-

alPI 4.
} Klicken Sie auf Login

Sie sehen jetzt den aktuellen Gerätestatus Ihres IndustrialPI 4.
} Klicken Sie auf das Register Apps.
} Klicken Sie auf den Button Start hinter dem Eintrag “PiCtory”, um PiCtory zu öffnen.

PiCtory öffnet sich.
} Öffnen Sie im Device-Catalog den Ordner I/O Devices.
} Wählen Sie das AIO.
} Ziehen Sie das AIO per Drag&Drop in den leeren Slot auf dem Configuration-Board.
} Legen Sie im Bereich Device Data die Grundeinstellungen für Ihre Adapter fest.

Diese Eingabe ist optional. Wenn Sie viele Geräte verwenden und die Daten später in ei-
nem anderen Programm weiterverarbeiten möchten, kann diese Eingabe sehr hilfreich
sein.

Im Value-Editor können Sie die Eingänge konfigurieren. Die detaillierten Einstellwerte fin-
den Sie in der folgenden Tabelle.
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Bezeichnung Werte Kommentar

Input1Range,
Input2Range,

Input3Range,

Input4Range

-10- 10 V
0 – 10 V

0 – 5 V

-5 – 5 V

0 – 20 mA

0 – 24 mA

4 – 20 mA

-25 – 25 mA

Stellen Sie hier den Ein-
gangsbereich für Span-
nungs- oder Strommessung
ein. Das Messverfahren
(Strom oder Spannung) so-
wie der Bereich sollte mit
dem Ausgang des ange-
schlossenen Sensors über-
einstimmen. Typisch sind bei
industriellen Sensoren 0-10
V oder 4-24 mA.

ADC_DataRate 5 Hz
10 Hz

20 Hz

40 Hz

80 Hz

160 Hz

320 Hz

640 Hz

Stellen Sie hier die Frequenz
ein, die dann beim Analog-
wandler als Datenrate ver-
wendet wird.
Die Rate mit der die Werte
im Prozessabbild aktualisiert
werden, ist ungefähr 1/5 die-
ser ADC-Datenrate.

Diese Frequenz gilt für alle 4
Eingänge.

Skalierung Eingang 1-4:
Input1Multiplier

Input1Divisor

Input1Offset

16-Bit-signed-Multiplier
16-Bit-unsigned-Divisor

16-Bit-signed-Offset

Hier können Sie eine Skalie-
rung für jeden Eingangska-
nal festlegen. Diese wird
durch die drei Konfigurati-
onswerte bestimmt und nach
folgender Formel aus dem
Originalwert (der in mV bzw.
µA vorliegt) berechnet:

Y = Multiplier/Divisor*X +
Offset

INFO

Bitte beachten Sie, dass Sie immer nur entweder Strom oder Spannung auf
einem Kanal messen können.

Bei einer Strommessung wird über eine Drahtbrücke, die Sie extern selber anbringen müs-
sen, ein Shunt-Widerstand zwischen den Eingängen für die Spannungsmessung geschal-
tet. Die Umstellung der Bereiche in PiCtory verändert zunächst in der Messelektronik so gut
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wie nichts, sondern wird nur für die Umrechnung in mV oder µA sowie die Überwachung
der Grenzwerte verwendet. Lediglich für den 0-5 V Bereich wird die Eingangsempfindlich-
keit des Messverstärkers erhöht, wodurch in diesem Bereich die doppelte Genauigkeit (ma-
ximale Abweichung ist in diesem Bereich 5 mV) erreicht wird.

Die Skalierung kann für Umrechnung in andere Einheiten oder zur nachträglichen Kalibrie-
rung eines Sensors verwendet werden. Bei der Berechnung im AIO-Modul wird eine 32-Bit-
Integer-Arithmetik verwendet. Die Ergebnisse werden dann aber wieder als 16-Bit-Werte im
Prozessabbild hinterlegt. Sollte das Ergebnis Y die Grenzen eines 16-Bit-signed-Wertes
überschreiten, so wird der Fehler erkannt und der Wert begrenzt. Die Ausgangswerte lie-
gen immer in der Einheit mV bzw. µA vor.

Beispiel:

Ein Näherungssensor gibt im Bereich zwischen 30 und 300 mm die Spannung 0 bis 10 V
aus. Um im Prozessabbild den Abstand in mm zu haben, müssen Sie die Parameter wie
folgt wählen:

Multiplier = 270, Divisor = 10000, Offset = 30

Arbeitet der Sensor stattdessen mit 4-20 mA müssen die Werte wie folgt von Ihnen festge-
legt werden:

Multiplier = 270, Divisor = 16000, Offset = -38

Zur ADC_DataRate:

Das Modul verwendet einen sogenannten Delta-Sigma-Wandler vom Typ ADS1248. Dieser
Wandler hat eine einstellbare Datenrate, die eng mit der Frequenzkurve des in einem sol-
chen Wandler enthaltenen Digitalfilters zusammenhängt. Genaue Diagramme zu den für je-
de Einstellung erzielten Frequenzgängen enthält das Datenblatt des ADS1248 auf den Sei-
ten 31 und 32. Wichtig für Ihre Messungen ist hier, dass niederfrequente Störsignale, wie
zum Beispiel ein 50 Hz Netzbrummen nur bei Einstellungen von 5 bis 20 Hz wirksam unter-
drückt werden. Die größte Messgenauigkeit bekommen Sie also mit diesen Einstellungen.
Auf der anderen Seite verringert sich dadurch die Aktualisierungsrate der Datenwerte im
Prozessabbild. Der Zusammenhang ist wie folgt:

ADC_Datenrate Aktualisierungsrate im PA:

5 Hz: 1 Hz

10 Hz: 2 Hz

20 Hz: 4 Hz

40 Hz: 8 Hz

80 Hz: 10 Hz

160 Hz: 25 Hz

320 Hz: max. 50 Hz

640 Hz: max. 125 Hz

Bitte beachten Sie, dass die Tabellenwerte für die Einstellungen 320 Hz und 640 Hz nur
Maximalwerte darstellen. Die tatsächlich erreichte Aktualisierungsrate kann in diesem Be-
reich durch die Auslastung der PiBridge deutlich niedriger liegen. Die Auslastung ist von Ih-
rer Konfiguration abhängig und daher kann bei diesen ADC_DataRates die jeweilige Aktua-
lisierungsrate nur experimentell auf Ihrem System und mit Ihrer Konfiguration ermittelt wer-
den. Generell sind diese Einstellungen daher nicht empfehlenswert.
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} Klicken Sie auf File>Save. Damit speichern Sie Ihre Datei.
} Klicken Sie auf Tools>Reset Driver. Damit aktivieren Sie die Änderungen für den Adap-

ter.

Tritt ein Fehler auf, erhalten Sie in den Eingangswerten des Prozessabbilds mit dem Na-
men InputStatus_1-4 Fehlermeldungen. Die Werte haben folgende Bedeutung:

Bitposition Statusmeldung

Bit 0 (LSB) 0 = Wert ist höher als die Untergrenze des
konfigurierten Bereichs.
1 = Wert ist mindestens 20 mV bzw. 20 µA
niedriger als die Untergrenze des konfigu-
rierten Bereichs.

Bit 1 0 = Wert ist niedriger als die Obergrenze
des konfigurierten Bereichs.
1 = Wert ist mindestens 20 mV bzw. 20 µA
höher als die Obergrenze des konfigurierten
Bereichs.

Im Feld InputValue_1-4 sehen Sie jetzt den Istwert des Eingangs. Wenn Sie den Eingang
als Spannungseingang verwenden, wird der Wert in mV angegeben. Wenn Sie den Ein-
gang als Stromeingang verwenden, wird der Wert in µA angegeben.

In den Feldern InputValue_1-4 können Sie symbolische Namen für die 4 Analogeingangs-
werte festlegen. Unter diesen Namen können Sie dann mit PiTest, einem selbstgeschriebe-
nen Programm oder einer Anwendungssoftware, Messwerte der angeschlossenen Senso-
ren aus dem Prozessabild auslesen. Die Werte werden dort für die Spannungsbereiche in
mV und für die Strombereiche in µA angegeben, falls Sie die Skalierung auf 1 belassen ha-
ben.

Möchten Sie die Einstellungen in Python oder C weiterverwenden?

Dann klicken Sie auf File>Export.

Ein Fenster öffnet sich. Sie können hier das Format der Datei bestimmen und den Datein-
amen angeben.

Klicken Sie auf Ok.

7.2 Analoge Ausgänge konfigurieren
Mit PiCtory können Sie Ihr IndustrialPI AIO konfigurieren. In diesem Kapitel werden die Ein-
stellwerte des “Value-Editors” für die analogen Ausgänge genauer beschrieben.

Voraussetzungen:
} Sie haben einen Webbrowser auf Ihrem PC installiert (z. B. Chrome).
} IndustrialPI 4 befindet sich in Ihrem Netzwerk.

Ihr IndustrialPI AIO besitzt zwei analoge Ausgänge. Diese Ausgänge können entweder
Spannung oder Strom ausgeben. Sie können hier Aktoren, wie z. B. Frequenzumrichter zur
Drehzahlsteuerung anschließen.

Damit Ihre Konfiguration auch funktioniert, ist es wichtig, dass Ihre Produkte an die richti-
gen Ausgangspins angeschlossen sind.
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INFO
Beachten Sie, dass Sie immer nur Strom oder Spannung auf einem Ka-
nal ausgeben können, obwohl es zwei getrennte Anschlüsse gibt.

} Öffnen Sie Ihren Webbrowser.
} Geben Sie die IP-Adresse Ihres IndustrialPI 4 in die Adresszeile Ihres Browsers ein.

Das Anmeldefenster öffnet sich.
} Melden Sie sich mit dem Benutzernamen “admin” an.
} Geben Sie Ihr Passwort ein. Sie finden es auf dem Aufkleber an der Seite Ihres Industri-

alPI 4.
} Klicken Sie auf Login.

Sie sehen jetzt den aktuellen Gerätestatus Ihres IndustrialPI 4.
} Klicken Sie auf das Register Apps.
} Klicken Sie auf den Button Start hinter dem Eintrag “PiCtory”, um PiCtory zu öffnen.

PiCtory öffnet sich.
} Öffnen Sie im Device-Catalog den Ordner I/O Devices.
} Wählen Sie das AIO.
} Ziehen Sie das AIO per Drag and Drop in den leeren Slot auf dem Configuration-Board.
} Legen Sie im Bereich Device Data die Grundeinstellungen für Ihre Adapter fest. Diese

Eingabe ist optional. Wenn Sie viele Geräte verwenden und die Daten später in einem
anderen Programm weiterverarbeiten möchten, kann diese Eingabe sehr hilfreich sein.

Im Value-Editor können Sie die Ausgänge konfigurieren. Die detaillierten Einstellwerte fin-
den Sie in der folgenden Tabelle.

PiCtory-Einstellung Werte Funktion

Output1Range,
Output2Range

Off (Ausgang inaktiv)
0 – 5 V

0 – 10 V

-5 – 5 V

-10 – 10 V

0 – 5,5 V

0 – 11 V

-5.5 – 5.5 V

-11 – 11 V

4 – 20 mA

0 – 20 mA

0 – 24 mA

Stellen Sie die Werteberei-
che für Strom oder Span-
nung ein, die die Ausgänge
abgeben sollen.
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PiCtory-Einstellung Werte Funktion

Output1EnableSlew,
Output2EnableSlew

On = Anstiegsrate verwen-
den
Off= Anstiegsrate nicht ver-
wenden

Hier können Sie festlegen,
ob Sie eine Anstiegsrate für
den jeweiligen Ausgang ver-
wenden möchten.
Die Anstiegsrate (slew-rate)
kontrolliert die Geschwindig-
keit, mit der sich die
Ausgangsspannung oder
Ausgangsstromstärke än-
dert, wenn Sie im Pro-
zessabbild einen neuen Wert
für einen Ausgang festlegen.

Output1SlewStepSize,
Output1SlewStepSize

1
2

4

8

16

32

64

128

Hier können Sie die Schritt-
weite der Anstiegsrate für
den jeweiligen Ausgang aus-
wählen. Die Schrittweite 1
entspricht dabei dem kleins-
ten Bitwert (LSB) vom
Wandler. Die Schrittweite
bestimmt zusammen mit der
Schritt-Taktfrequenz die
Steilheit des Übergangs (der
Flanke) zwischen zwei Ana-
logwerten.

Output1SlewUpdateFreq,
Output1SlewUpdateFreq

258 kHz
200 kHz

154 kHz

131 kHz

116 kHz

70 kHz

38 kHz

26 kHz

20 kHz

16 kHz

10 kHz

8,3 kHz

6,9 kHz

5,5 kHz

4,2 kHz

3,3 kHz

Hier können Sie die Schritt-
Taktfrequenz für die An-
stiegsrate des jeweiligen
Ausgangs auswählen. Die
Schrittweite bestimmt zu-
sammen mit der Schritt-Takt-
frequenz die Steilheit des
Übergangs (der Flanke) zwi-
schen zwei Analogwerten.
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PiCtory-Einstellung Werte Funktion

Skalierung Ausgang 1:
Output1Multiplier

Output1Divisor

Output1Offset

Skalierung Ausgang 2:

Output2Multiplier

Output2Divisor

Output2Offset

16-Bit-signed-Multiplier
16-Bit-unsigned-Divisor

16-Bit-signed-Offset

Hier können Sie eine Skalie-
rung für jeden Ausgangska-
nal festlegen. Diese wird
durch die drei Konfigurati-
onswerte bestimmt und
nachfolgender Formel aus
dem Originalwert (der in mV
bzw. µA vorliegt) berechnet:
Y = X*Multiplier/Divisor +
OffsetX ist der Wert für den
Output.

Y steht für die verwendete
Spannungsversorgung in
Millivolt.

Die Skalierung kann für die Umrechnung in andere Einheiten oder zur nachträglichen Kali-
brierung eines Aktors verwendet werden. Bei der Berechnung im AIO-Modul wird eine 32-
Bit-Integer-Arithmetik verwendet. Die Ergebnisse werden dann als 16-Bit-Werte zum DAC
gesendet. Sollte das Ergebnis Y die Grenzen eines 16-Bit-signed Wertes überschreiten, so
wird der Fehler erkannt und der Wert begrenzt. Die Ausgangswerte müssen für einen Ska-
lierungsfaktor eins immer in der Einheit mV bzw. µA ins Prozessabbild abgelegt werden.

Beispiel:

Ein Frequenzumrichter steuert einen Elektromotor an. Er hat einen Analogeingang von 0
bis 10 V. Dabei entspricht 0 V einer Motordrehzahl von 200 upm und 10 V einer Drehzahl
von 3000 upm. Um im Prozessabbild die Drehzahl in upm zu hinterlegen, müssen Sie für
den Ausgangsbereich 0-10 V die Parameter wie folgt wählen:

Multiplier = 100, Divisor = 28, Offset = -714
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Die Einstellungen rund um die “Slew-Rate” (Flankensteilheit) haben folgende Bedeutung:

Nehmen wir an, Sie haben einen Ausgangsbereich von 0 bis 10 V gewählt. Im Prozessab-
bild liegt für Kanal1 ein Ausgangswert von 3 V. Dieser Wert soll sich nun auf 8 V ändern.
Deshalb schreiben Sie statt den 3000 mV die Zahl 8000 an den entsprechenden Offset im
Prozessabbild. Beim nächsten PiBridge Zyklus wird diese Zahl dann dem DAC (Digital to
Analog Converter) übergeben, der daraus die Analogspannung für den Ausgang generiert.
Dies passiert also mit einer gewissen Verzögerungszeit von 10-40 ms, je nach Auslastung
der PiBridge (die von der Konfiguration abhängt). Nach dieser Verzögerung würde die Aus-
gangsspannung sehr schnell von 3 V auf 8 V springen. Die Anstiegssteilheit der Spannung
ist dabei nur von der Gesamtkapazität am Ausgang abhängig (die unter anderem von den
angeschlossenen Geräten abhängt). Sie dürfte in der Regel bei einigen µs liegen. Oft ist
diese Flankensteilheit unerwünscht, weil sie extrem hohe Frequenzanteile hat, die zur
Störausstrahlung und anderen Problemen führen kann. Daher können Sie die Flankensteil-
heit künstlich verringern. Dazu schalten Sie “Output?EnableSlew” auf “On”. Nun wird der
DAC, sobald er die neuen Daten (8000) hat, in kleinen Schritten die Ausgangsspannung er-
höhen, bis die 8 V erreicht sind. Die Amplitude der Schritte stellen Sie mit “Output?Slew-
StepSize” ein. Diese Schrittweite wird in der Einheit “LSB” (also Last-Significant-Bit) ange-
geben. Da unser Wandler bei jedem Ausgangsbereich mit 16 Bit Auflösung arbeitet, beträgt
die Schrittweite des niederwertigsten Bits (LSB) im 0-10V Bereich 10V/2^16 = 0,15 mV
(bzw. 0,30 µA im Bereich 4-20 mA). Wie viele dieser Schritte der DAC benötigt, hängt von
dem Spannungssprung ab: Bei unserem Beispiel sind es mit einer Schrittweite von 1 also
5000 mV / 0,15 mV = 33.333 Schritte. In welcher Zeit nun diese Schritte vollzogen werden,
wird durch die Taktrate bestimmt, mit der die Schritte in das Signal eingebaut werden. Sie
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können von Ihnen durch den Parameter “Output?SlewClock” eingestellt werden. Bei einer
eingestellten Taktrate von 3,3 kHz braucht die Flanke von 5 V also 33.333* 1/3300 s = 10
s. Bei der Einstellung 258 kHz wären es demnach 130 ms. Die Flankensteilheit beträgt also
bei 3,3 kHz Taktrate 0,5 V/s bzw. 38 V/s bei 258 kHz Taktrate. Mit größeren Schrittweiten
können Sie die Flankensteilheit drastisch erhöhen. Allerdings macht das Signal
dann“Sprünge”, d.h. es bekommt deutlich mehr hochfrequente Signalanteile.
} Klicken Sie auf File>Save. Sie speichern die Datei.
} Klicken Sie auf Tools>Reset Driver. Damit aktivieren Sie die Änderungen für den Adap-

ter.

Tritt ein Fehler auf, erhalten Sie in den Eingangswerten des Prozessabbilds mit dem Na-
men OutputStatus_1 und OutputStatus_2 Fehlermeldungen. Die jeweiligen Bits in den Sta-
tusbytes haben folgende Bedeutung:

Bitposition Statusmeldung

0 (LSB) Temperaturfehler vom Ausgangsbaustein.
Der Ausgangsbaustein ist durch eine länge-
re Überlastung (Kurzschluss) überhitzt.

1 Open Load Fehler vom Stromausgang. Im
Betriebsmodus “Stromausgang” ist der an-
geschlossene Stromkreis zu hochohmig,
weil zum Beispiel die Leitung unterbrochen
ist.

2 Interner CRC Fehler vom Ausgangsbau-
stein. Dieser Fehler deutet auf einen Hard-
waredefekt oder gravierende externe Störsi-
gnale hin.

3 Bereichsfehler: Der Ausgangswert im Pro-
zessabbild liegt außerhalb des konfigurier-
ten Ausgangsbereichs.

4 Reserviert für interne Zwecke.

5 Die Versorgungsspannung für das Modul ist
geringer als 10,2 V.

Die Ausgänge wurden abgeschaltet.

6 Die Versorgungsspannung für das Modul ist
größer als 28,8 V. Die Ausgänge wurden
abgeschaltet.

7 (MSB) Timeout bei der Verbindung zum Industrial-
PI 4 (z. B. wegen einer Störung der Pi-
Bridge oder wenn das Treiberprogramm Pi-
Control nicht mehr korrekt auf dem Industri-
alPI 4 läuft. Die Ausgänge wurden abge-
schaltet.
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INFO

Beachten Sie: In den Fällen, in denen die Ausgänge aus Sicherheits-
gründen abgeschaltet wurden, stehen die Ausgänge erst wieder nach
einem Neustart des Gerätes oder einem Reset der PiBridge (z.B. piTest
-x) zur Verfügung.

Möchten Sie die Einstellungen in Python oder C weiterverwenden?

Dann klicken Sie auf File>Export.

Ein Fenster öffnet sich. Sie können hier das Format der Datei bestimmen und den Datein-
amen angeben.

Klicken Sie auf Ok.

7.3 RTD-Kanäle für Temperaturmessungen konfigurieren
Mit PiCtory können Sie Ihr IndustrialPI AIO-Modul konfigurieren. In diesem Kapitel be-
schreiben wir die Einstellwerte des “Value-Editors” für die RTD-Kanäle.

Voraussetzungen:
} Sie haben einen Webbrowser auf Ihrem PC installiert (z. B. Chrome).
} IndustrialPI 4 befindet sich in Ihrem Netzwerk.

Ihr AIO besitzt 2 RTD-Kanäle. Sie können hiermit die Temperatur von angeschlossenen
Pt100 und Pt1000 Sensoren ermitteln.

Damit Ihre Konfiguration auch funktioniert, ist es wichtig, dass Ihre Produkte an die richti-
gen Eingangspins angeschlossen sind.

INFO

Beachten Sie, dass das AIO-Modul für einen 2-Draht Sensor die 3-Draht
Messmethode verwendet. Simulieren Sie den fehlenden 3. Draht durch eine
Steckbrücke am Modul zwischen den Pins 10 und 12 bzw. 9 und 18.

} Öffnen Sie Ihren Webbrowser.
} Geben Sie die IP-Adresse Ihres IndustrialPI 4 in die Adresszeile Ihres Browsers ein.

Das Anmeldefenster öffnet sich.
} Melden Sie sich mit dem Benutzernamen “admin” an.
} Geben Sie Ihr Passwort ein. Sie finden es auf dem Aufkleber an der Seite Ihres Industri-

alPI 4.
} Klicken Sie auf Login.

Sie sehen jetzt den aktuellen Gerätestatus Ihres IndustrialPI 4.
} Klicken Sie auf das Register Apps.
} Klicken Sie auf den Start-Button hinter dem Eintrag “PiCtory”, um PiCtory zu öffnen.

PiCtory öffnet sich.
} Öffnen Sie im Device Catalog den Ordner I/O Devices.
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} Wählen Sie das AIO-Modul
} Ziehen Sie das AIO per Drag and Drop in den leeren Slot auf dem Configurations-Board.
} Legen Sie im Bereich Device Data die Grundeinstellungen für Ihre Adapter fest. Diese

Eingabe ist optional. Wenn Sie viele Produkte verwenden und die Daten später in einem
anderen Programm weiterverarbeiten möchten, kann diese Eingabe sehr hilfreich sein.
Im Value-Editor können Sie die RTD-Kanäle konfigurieren. Die detaillierten Einstellwerte
finden Sie in der folgenden Tabelle:

Bezeichnung Werte Kommentar

RTD1Type,
RTD2Type

Pt100
Pt1000

Stellen Sie ein, welchen
Messfühlertyp Sie verwen-
den.

RTD1Wiring,
RTD2Wiring

2-Wire
3-Wire

4-Wire

Wählen Sie das Messverfah-
ren passend für Ihren Tem-
peraturfühler aus.

RTD 1 Skalierung
RTD1Multiplier

RTD1Divisor

RTD1Offset

RTD 2 Skalierung

RTD2Multiplier

RTD2Divisor

RTD2Offset

16-Bit-signed-Multiplier
16-Bit-unsigned-Divisor

16-Bit-signed-Offset

Hier können Sie eine Skalie-
rung für die RTD-Kanäle
festlegen. Diese wird durch
die drei Konfigurationswerte
bestimmt und nach folgender
Formel aus dem Originalwert
(der in 1/10 °C vorliegt) be-
rechnet:

Y = Multiplier/Divisor*X +
Offset

Die Skalierung kann für Umrechnung in andere Einheiten oder zur nachträglichen Kalibrie-
rung eines Temperaturfühlers verwendet werden. Bei der Berechnung im AIO-Modul wird
eine 32-Bit-Integer-Arithmetik verwendet. Die Ergebnisse werden dann aber wieder als 16
Bit Werte im Prozessabbild hinterlegt. Sollte das Ergebnis Y die Grenzen eines 16 Bit si-
gned Wertes überschreiten, so wird der Fehler erkannt und der Wert begrenzt.

Beispiel:

Um die Temperatur in °C ohne Nachkommastellen im Prozessabbild zu haben muss die
Einstellung so aussehen:

Multiplier = 1, Divisor = 10, Offset = 0

Um die Temperatur in °F ins Prozessabbild zu bekommen müssen die Parameter so einge-
stellt werden:

Multiplier = 18, Divisor = 100, Offset = 32

Für Prozessdaten in °Kelvin brauchen Sie diese Werte:

Multiplier = 1, Divisor = 10, Offset = 273
} Klicken Sie auf File>Save. Damit speichern Sie Ihre Datei.
} Klicken Sie auf Tools>Reset Driver. Damit aktivieren Sie die Änderungen für den Adap-

ter.
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Tritt ein Fehler auf, erhalten Sie in den Eingangswerten des Prozessabbilds mit dem Na-
men Bytes RTDStatus_1 und RTDStatus_2 Fehlermeldungen. Die Werte haben folgende
Bedeutung:

Bitposition Bedeutung Kommentar

Bit 0 (LSB) 0 = Temp. ist höher als -200
°C,
1 = Ermittelte Temp. ist nied-
riger als -200 °C (z. B. Kurz-
schluss im Sensor oder Ka-
bel).

Falls die ermittelte Tempera-
tur außerhalb des Bereiches
ist, wird der jeweilige Grenz-
wert ausgegeben (-200,0°C
oder 850,0°C) und zusätzlich
das entsprechende Statusbit
gesetzt.

Bit 1 0 = Temp. ist niedriger als
850 °C,
1 = Ermittelte Temp. ist hö-
her als 850°C (z. B. kein
Sensor angeschlossen oder
Leitungsbruch).

In den Feldern RTDValue_1 und RTDValue_2 können Sie symbolische Namen für die bei-
den Temperaturwerte festlegen. Unter diesen Namen können Sie dann mit PiTest, einem
selbstgeschriebenen Programm oder einer Anwendungssoftware, Messwerte der ange-
schlossenen Sensoren aus dem Prozessabbild auslesen. Die Werte werden dort in 1/10 °C
angegeben, falls Sie die Skalierung auf 1 belassen haben.

Möchten Sie die Einstellungen in Python oder C weiterverwenden?

Dann klicken Sie auf File>Export.

Ein Fenster öffnet sich. Sie können hier das Format der Datei bestimmen und den Datein-
amen angeben.

Klicken Sie auf Ok.
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8 Betrieb

8.1 Anzeigeelemente und Meldungen
LED Signal Bedeutung

Power an, grün Die Verbindung zum IndustrialPI 4 ist hergestellt.

blinkt, rot Es wurde noch keine Verbindung zum IndustrialPI 4 her-
gestellt (Initialisierungsphase).

an, rot Die Verbindung zum IndustrialPI 4 wurde unterbrochen.
Prüfen Sie, ob die PiBridge richtig eingesteckt ist.

Out aus Es wurde noch keine Verbindung zum IndustrialPI 4 her-
gestellt (Initialisierungsphase).

an, grün Ausgänge sind betriebsbereit.

blinkt, rot Bereichsfehler. Die Werte vom IndustrialPI 4 sind zu
hoch oder zu niedrig.

an, rot Anderer Fehler. Überprüfen Sie den Ausgangsstatus im
Prozessabbild.

In aus Es wurde noch keine Verbindung zum IndustrialPI 4 her-
gestellt (Initialisierungsphase).

an, grün Eingänge sind betriebsbereit.

blinkt, rot Bereichsfehler. An einem oder mehreren Ausgängen lie-
gen zu hohe Spannungen oder zu hoher Strom an.
Überprüfen Sie den Eingangsstatus im Prozessabbild.

Um einen Fehlerzustand des IndustrialPI AIO-Moduls genau auszuwerten, muss Ihre An-
wendungssoftware die Statuseinträge im Prozessabbild auswerten. Statuseinträge werden
als Eingangswerte vom PiControl-Treiber dort abgelegt. Die Position (Offset) im Prozessab-
bild können Sie z. B. dem Offsetexport in PiCtory entnehmen oder über die symbolischen
Namen der jeweiligen Statuswerte auch mit dem Kommandozeilen-Tool piTest abfragen.
Die Bedeutung der einzelnen Bits der Status-Bytes finden Sie in der folgenden Tabelle:

Bit Ursache LED Anzeige Reaktion

Statusmeldungen Analogausgänge

Bit 0 (LSB) Temperaturfehler
vom Ausgangsbau-
stein. Der Ausgangs-
baustein ist durch ei-
ne längere Überlas-
tung (Kurzschluss)
überhitzt.

rot an –

Bit 1 Open Load Fehler
vom Stromausgang.
Im Betriebsmodus
“Stromausgang” ist
der angeschlossene
Stromkreis zu hoch-
ohmig, weil zum Bei-
spiel die Leitung un-
terbrochen ist.

rot an –
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Bit Ursache LED Anzeige Reaktion

Bit 2 Interner CRC Fehler
vom Ausgangsbau-
stein. Dieser Fehler
deutet auf einen
Hardwaredefekt oder
gravierende externe
Störsignale hin.

rot an –

Bit 3 Bereichsfehler: Der
Ausgangswert im
Prozessabbild liegt
außerhalb des konfi-
gurierten Ausgangs-
bereichs.

rot blinkt Der Ausgang wird
auf den maximal
oder minimal zulässi-
gen Wert gesetzt.

Bit 4 Reserviert für interne
Zwecke.

Bit 5 Versorgungsspan-
nung des AIO-Mo-
duls liegt unter 10,2
V.

rot an Die Ausgänge wer-
den auf 0 gesetzt, da
kein sicherer Betrieb
gewährleistet werden
kann.

Bit 6 Versorgungsspan-
nung des AIO-Mo-
duls liegt über 28,8
V.

rot an Die Ausgänge wer-
den auf 0 gesetzt, da
kein sicherer Betrieb
gewährleistet werden
kann.

Bit 7 (MSB) Timeout bei der Ver-
bindung zum Indus-
trialPI 4 (z. B. wegen
einer Störung der Pi-
Bridge oder wenn
das Treiberpro-
gramm PiControl
nicht mehr korrekt
auf dem IndustrialPI
4 läuft.

rot an Die Ausgänge wer-
den auf 0 gesetzt.
Dies ist der ange-
nommene sichere
Zustand, der auch
beim Starten des
AIO an den Ausgän-
gen anliegt.

Statusmeldungen Analogeingänge

Bit 0 (MSB) Eingangswert liegt
mindestens 24 mV
oder 20 µA unter
dem konfigurierten
Eingangsbereich.

rot blinkt –

Bit 1 Eingangswert liegt
mindestens 24 mV
oder. 20 µA über
dem konfigurierten
Eingangsbereich.

rot blinkt –

Statusmeldungen Temperatureingänge

Bit 0 (MSB) Ermittelte Tempera-
tur unter-200 °C oder
Kurzschluss des
Sensors.

– –
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Bit Ursache LED Anzeige Reaktion

Bit 1 Ermittelte Tempera-
tur über 850 °C, kein
Sensor angeschlos-
sen oder Leitungs-
bruch.

– –
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9 Abmessungen
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10 Technische Daten
Norm EN 61131-2

Gehäuseabmessungen (H x B x T) 96 x 22,5 x 110,5 mm

Gehäusevariante Hutschienengehäuse (für Hutschienenvari-
ante EN 50022)

Gehäusematerial Kunststoff

Gewicht ca. 115 g

Schutzart IP20

Spannungsversorgung 12 - 24 V (-15 %/+20 %)

Stromaufnahme max. 200 mA bei 24 V (Volllast) 
max. 400 mA bei 12 V (Volllast) 
max. 500 mA im Anlauf

Zulässige Betriebstemperatur -30…+55 °C

Zulässige Lagertemperatur -40…+85 °C

Max. relative Luftfeuchtigkeit (bei 40 °C) 93 % (keine Betauung)

Steckverbinder 1 x 8-polige Federkraft-Steckverbinder

Spannungsmessbereiche ±10 V | ±5 V | 0…10 V | 0…5 V

Stromeingangsbereiche 0…20 mA | 0…24 mA | 4…20 mA | ±25 mA

Temperatureingangsbereich -200…+850 °C

Ausgangsspannungsbereiche ±10 V | ±11 V | ±5 V | ±5,5 V | 
0…10 V | 0…11 V | 0…5 V | 0…5,5 V

Ausgangsstrombereiche 0…20 mA | 0…24 mA | 4…20 mA

Anzahl der Eingangskanäle
davon für Spannung

davon für Strom

davon für RTDs (Pt100/Pt1000)

6
max. 4

max. 4

2

Anzahl der Ausgangskanäle
davon für Spannung

davon für Strom

2
max. 2

max. 2

Galvanische Trennung
Eingänge untereinander

Eingänge gegen Ausgänge

Ausgänge untereinander

Systembus gegen Eingänge/Ausgänge

Nein

Ja

Nein

Ja

Eingangstyp
Spannung/Strom

Temperatursensor (RTD)

differential

2-, 3-, 4-Draht

Ausgangstyp Single-ended, common-ground, kurz-
schlussfest
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ADC Typ 24 Bit ΔΣ

DAC Typ 16 Bit

Eingangsauflösung
Prozessabbild

Spannung Strom

Temperatur

1 mV

1 µA

0,1 K

Ausgangsauflösung Prozessabbild
Spannung

Strom

1 mV

1 µA

Max. Gesamteingangsfehler (bei 25 °C
Umgebungstemperatur)
Spannung (alle Eingangsbereiche)

Strom (alle Eingangsbereiche)

Temperatur (kompletter Bereich)

±10 mV (±5 mV @ 0…5 V Bereich)

±20 µA (±24 µA @ 0…24 µA Bereich)

±0,5 K

Max. Gesamteingangsfehler (bei -30…+55
°C Umgebungstemperatur)
Spannung (alle Eingangsbereiche)

Strom (alle Eingangsbereiche)

Temperatur (kompletter Bereich)

±10 mV

±72 µA

±1,5 K

Max. Gesamtausgangsfehler (bei 25 °C
Umgebungstemperatur)
Spannung (alle Eingangsbereiche)

Strom (alle Eingangsbereiche)

±15 mV

±20 µA

Max. Gesamtausgangsfehler (bei -30…+55
°C Umgebungstemperatur)
Spannung (alle Eingangsbereiche)

Strom (alle Eingangsbereiche)

±15 mV

±72 µA

Wandlungszeit Eingänge (Datenrate im Pro-
zessabbild)

8…1000 ms (einstellbar)

Ausgangsdatenrate 1 PiBridge Zyklus

Flankensteilheit Ausgang
Einstellbare digital Flanke

1 LSB@3,3 kHz bis 128 LSB@258 kHz

Eingangsimpedanz
Spannung Strom >900 kΩ

<250 Ω

Ausgangsimpedanz
Spannung

maximale kapazitive Last

<16 Ω

5 nF @ 1 kΩ
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Max. Lastwiderstand bei Stromausgang 600 Ω

Min. Lastwiderstand bei Spannungsaus-
gang

1 kΩ

Weitere Eigenschaften Alle Ein- und Ausgänge können linear ska-
liert werden Übertemperaturüberwachung
Überstromüberwachung
Bereichsüberwachung

Optische Anzeige 3 Status LEDs (2-farbig)

Konformität CE, RoHS

UL-Zertifizierung Geplant
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11 Bestelldaten
IndustrialPI AIO Erweiterungsmodul für den Industrial PI 4, 6 Ein-

gangskanäle, 2 Ausgangskanäle für Strom, Span-
nung, RTDs, Ausgangsspannungsbereiche: ±10 V,
±11 V, ±5 V, ± 5,5 V, 0…10 V, 0…11 V, 0…5 V, 0…
5,5 V, Ausgangsstrombereiche: 0 … 20 mA, 0 … 24
mA, 4 … 20 mA,

A3000004



 

Wir sind international vertreten. Nähere Informationen entnehmen Sie bitte unserer Homepage  
www.pilz.com oder nehmen Sie Kontakt mit unserem Stammhaus auf.

Stammhaus: Pilz GmbH & Co. KG, Felix-Wankel-Straße 2, 73760 Ostfildern, Deutschland
Telefon: +49 711 3409-0, E-Mail: info@pilz.de, Internet: www.pilz.com
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Technische Unterstützung von Pilz erhalten Sie rund um die Uhr. 

Pilz entwickelt umweltfreundliche Produkte unter Verwendung 

ökologischer Werkstoffe und energiesparender Techniken.  

In ökologisch gestalteten Gebäuden wird umweltbewusst  

und energiesparend produziert und gearbeitet. So bietet Pilz 

Ihnen Nachhaltigkeit mit der Sicherheit, energieeffiziente 

Produkte und umweltfreundliche Lösungen zu erhalten.

Amerika

Brasilien

+55 11 97569-2804

Kanada

+1 888 315 7459

Mexiko

+52 55 5572 1300

USA (toll-free)

+1 877-PILZUSA (745-9872)

Asien

China

+86 400-088-3566 

Japan

+81 45 471-2281

Südkorea

+82 31 778 3300

Australien und Ozeanien

Australien

+61 3 95600621

Neuseeland

+64 9 6345350

Europa

Belgien, Luxemburg

+32 9 3217570

Deutschland

+49 711 3409-444

Frankreich

+33 3 88104003

Großbritannien

+44 1536 462203

Irland

+353 21 4804983

Italien, Malta

+39 0362 1826711

Niederlande

+31 347 320477

Österreich

+43 1 7986263-444

Schweiz

+41 62 88979-32

Skandinavien

+45 74436332

Spanien

+34 938497433

Türkiye

+90 216 5775552

Unsere internationale  

Hotline erreichen Sie unter:  

+49 711 3409-222  

support@pilz.com

Titelseite
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